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Software License Agreement
PLEASE READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY BEFORE USING THE ACCOMPANYING
SOFTWARE. This software license agreement (this "agreement") is a legally binding agreement between you and
Wagner Meters. By accepting this license and proceeding to download the software accompanying this agreement and
related documentation, whether on disk, in read-only memory or on any other media, (collectively, the "software"), you are
agreeing to be bound by the terms and conditions of this agreement. If you do not agree to the terms and conditions of
this agreement, do not install or use the software, and promptly return the unused software to the person from whom you
obtained it.
1.
License. Subject to the terms of this agreement, Wagner Meters grants to you a nonexclusive license to use the
software on a single computer. You may make (a) one copy of the software (excluding documentation) in machinereadable form for your exclusive use on a computer and (b) one copy of the software (excluding documentation) in
machine-readable form for backup purposes only; provided that each such copy is a true and complete copy, that you
reproduce on each such copy the copyright notice and any other proprietary legends on the original copy of the Software,
and that no more than one copy of the Software is used at any one time.
2.
Restrictions. You acknowledge that the software, and its structure, organization and source code, contain
copyrighted material, trade secrets and other proprietary material owned by Wagner Meters. Accordingly, you may not
except to the extent permitted by any applicable law (a) de-compile, reverse engineer, disassemble or otherwise reduce
the software to a human-perceivable form, (b) modify, adapt, alter, translate or create derivative works from the software,
(c) merge the software with other software, (d) sublicense, network, rent, lease, loan, or distribute the software in whole or
in part, or (e) otherwise use or copy the software except as expressly permitted under Section 1. In addition, you may not
electronically transmit the software from one computer to another or over a network. All rights in and to the software not
expressly granted to you under this agreement are reserved to Wagner Meters.
No warranty or representation is given that the functions contained in the software will meet your requirements, or that the
operation of the software will be uninterrupted or error-free, or that defects in the software will be corrected. Furthermore,
no warranty or representation is given regarding the use or the results of the use of the software or related documentation.
No oral or written information or advice given by any person or entity shall create a warranty or representation or in any
way increase the scope of this warranty.
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Wagner Meters is not required to provide any maintenance or support services with respect to the software under this
agreement.

Limitation of Liability
Under no circumstances, including negligence, shall Wagner Meters be liable for any consequential, incidental, indirect,
exemplary, special or punitive damages, including without limitation any loss of data, or loss of profit, savings, business or
goodwill or other similar loss resulting from the use or inability to use the software, even if Wagner Meters has been
advised or the possibility of such damages, or for any claim by any third party.
In no event shall the total liability to you for all damages, losses, and causes of action (whether in contract, tort (including
negligence) or otherwise) exceed the amount paid by you for the software.

Technical Support
Should you require support, please consult your printed documentation to resolve your problem. If you are still
experiencing difficulty, you may contact a Wagner Technical Service representative during normal business hours—
7:30 a.m. to 4:00 p.m. Pacific Standard Time, Monday through Friday.
Voice:

(541) 582-0541

Fax:

(541) 582-4138

E-Mail:
Mail:

support@wagnermeters.com
Technical Services Department
Wagner Meters
326 Pine Grove Road
Rogue River, OR 97537
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1 AN INTRODUCTION TO
STAT-PAK FOR WINDOWS

The program allows you to:
• Customize your L612 reports with company name
and meter number.
• Archive L612 group data to a hard drive or diskette
for later retrieval.
• Recall archived reports for viewing and printing.
• Generate custom Summary Reports.
• Export data to popular spreadsheet programs for
more complex analysis.
• Custom tailor the L612 species list for your needs.

ABOUT THIS MANUAL
The Stat-Pak User's Guide is designed to pilot you
through the basic features of Stat-Pak, and to introduce
you to the advance features.
Warning: This computer program is protected by
copyright law and international treaties.
Unauthorized reproduction or distribution of this
program or any portion of it may result in severe
civil and criminal penalties, and will be prosecuted
to the maximum extent possible under the law.

Welcome to Stat-Pak for Windows! This is the most
powerful hand-meter moisture analysis program in the
wood products industry. This program allows you to
manage all aspects of moisture quality control. You can
store, recall, and analyze the data collected from the
L612.
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1 An Introduction to Stat-Pak gives you an overview of
the contents of the manual and what Stat-Pak does.
2 Getting Started shows you step-by-step how to install,
run, and quit the Stat-Pak software.
3 Downloading Data to the Meter describes the
functionality available to custom configure your L612
hand-meter.
4 Uploading Data from the Meter describes how to get
your L612 hand-meter data into the Stat-Pak database.
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Note: If upgrading Stat-Pak for Windows with a newer
version of software please refer to Technical Bulletin 17,
located in the back of this manual.

5 Working with the Data tells you how to move and edit
data within the Stat-Pak database to generate reports.
6 System Properties tells you how to set the Stat-Pak
program settings for easiest viewing, language, and
communications port options.
7 Database Functions describes how to import, export, or
repair the Stat-Pak data.
8 Language Translator allows you to internationalize the
Stat-Pak language for your application.
Appendix A Species List gives you the Specific Gravity
values for the most commonly used species of wood that
are used in your L612 hand-meter.

2 GETTING STARTED
The Stat-Pak software will operate on any PC compatible
with the installation requirements in this section. An
available 9-pin serial port (COM 1, COM 2, etc…) or a
USB port with the included USB to serial converter
installed must be available to communicate with the
L612.

500-61202-002 Rev. E
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LOADING STAT-PAK
To install Stat-Pak on your hard drive, simply put the
Stat-Pak disk into the CD drive and the installer program
should automatically start. If it does not, locate the file
named Setup.exe on the CD drive and double click on it
to initiate the installer program.
The installer wizard will lead you through the installation
process. Click the Next and Finish buttons to complete
the process.
By default the application is installed to "C:\Program
Files\StatPak".
Note: If the PC does not have the required version of
Internet Explorer, the installer will exit with an error
message. A compatible version of Internet Explorer has
been provided on the CD for download in the event that
the PC does not have the correct version. See the
instructions below for loading Internet Explorer.
The last page of the installation wizard may report that
your PC will be re-started to complete the installation
process. In this case you will not be able to run the
software until this is done.

LOADING INTERNET EXPLORER
If the Stat Pak Installer indicated that the Internet
Explorer version is not compatible, you can load it from
the CD as follows:
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Open the CD drive directory by double clicking on the
“My Computer” icon. Right mouse click on the CD drive
icon and select “Open”. Locate the file folder named
Internet Explorer 6 and double click on it to view the files.
Double click on ie6setup.exe to run the installer program.
The installer wizard will lead you through the installation
process. Click the Next and Finish buttons to complete
the process.
The last page of the installation wizard will prompt you to
save any open work because the PC will be re-started to
complete the installation process.

L612 TO PC CONNECTION
Various function and manager windows require
communicating with the L612 hand-meter to retrieve
information.
To allow the L612 meter to communicate with the PC
computer, the following equipment is provided:
• L612 hand-meter
• Coiled serial cable
• Female 9-pin (DB9F) to RJ11 (i.e. phone jack)
adapter (shown below)
• USB to serial converter with driver

•

Stat-Pak for Windows software

Follow these steps to establish communications using a
PC Serial port.
• Plug one end of the serial cable into the COMM
port of the L612.
• Plug the other end into the 9-pin to RJ11 adapter.
• Plug the 9-pin to RJ11 adapter into the serial port
(COM 1) of your PC computer. If the COM 1 port
is not available, use COM 2. If there is no
available COM port, and your PC is equipped with
a USB port, then use the included USB to serial
converter. The USB to serial converter package
includes a diver that must be installed prior to use.
Please follow the installation instructions included
with the converter, before attempting to connect
the L612.
• Stat-Pak is configured to communicate through
COM 1 by default. For an alternate COM port,
please refer to the System Properties section (6)
on how to configure Stat-Pak to recognize and
alternate COM port.
CAUTION: The 25-pin to RJ11 adapter will not
work on a 25 pin serial port. To work, a DB25F to
DB25F null modem adapter is needed.
•

Turn on the L612 meter by pressing the STORE
button.

RUNNING STAT-PAK
To run your 612 Stat-Pak software, left click your Start
menu on the Windows Tool Bar (lower left on screen).
500-61202-002 Rev. E
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Select Programs - Stat Pak – Stat Pak.
L612 group data and species settings will be
automatically uploaded to the Stat-Pak program view
(lower panels) upon program launch, which can take up
to one minute. If you need to re-upload meter data, you
can select View-Refresh from the pull down menu, or use
the F5 key.

500-61202-002 Rev. E
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QUITTING STAT-PAK

fields available in the Resource database. Select a
language and click OK to continue.

WARNING! Never shut down the computer without
performing the following procedure or damage to StatPak may result. Following, is the procedure for quitting
Stat-Pak.

The selected language will be loaded automatically for all
future sessions.

From the "File" menu, select "Exit", or click on the "X"
icon shown at the top right corner of the window.

To select a language other than English, you will need to
use the Language Translator. Refer to the Language
Translator section of this manual.

INSTALLATION REQUIREMENTS
The minimum supported PC configurations are as
follows:
Windows 95 with the Y2K Update (w95y2k.exe) and
Internet Explorer 5.0 or later
Windows 98 with the Y2K Update 2 (y2k.exe +
Y2kw98_2.exe) and Internet Explorer 5.0 or later
Windows 98 Second Edition
Windows Millennium
NT 4 SP5 (or greater) and IE 5.0 or later
Windows 2000
Windows XP

RUNNING THE APPLICATION FOR THE FIRST TIME
When running the program for the first time there is no
default language set. This causes a language selection
panel to be displayed. The combo box lists all language
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NOTE: When the program is started it attempts to upload
data from a meter. If the meter is switched off or
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disconnected a dialog will appear to this effect. There
are two options:



A demonstration database could be supplied containing
sample data.

Switch on the meter, wait for it to initialize and
then press OK. The program will upload the data
and continue.
Press Cancel. The program will continue loading
without uploading data. In this case the meter data
is not immediately available, but can be accessed
later if required.

The user can create a dummy database for training and
experimentation purposes.
If data is being gathered in unconnected sites, each site
can create a local database with a meaningful file name.
These database files can be collected and combined
centrally if required.

When the program is run for the first time (and until a
new database is created) it should automatically load the
default database.

In a networked environment the main database can be
placed in a shared folder on the server. Any user can
open the shared file and work with it.

You may re-size the window and panels to suit your
screen. Generally the right hand (list view) panels should
be as wide as possible to maximize the number of fields
visible without scrolling.

This functionality is invisible to the casual user. The
currently selected database will always load on start-up
unless a problem occurs (e.g. someone has move the file
or the network is down).

DEMONSTRATOR DATABASE

SPECIAL EDITING KEYSTROKES

If the top panels are empty, you must manually open the
‘L612’ database. The database demonstrator file is called
‘L612.wsp’ and is normally located in the application
folder (e.g. C:\Program Files\StatPak).
Click on the file menu and select ‘Open’. Locate the file
‘L612.wsp’ and open it. The demonstrator database
serves the following purposes:

There are several ways to invoke the various editing
functions. It is possible to select the required option from
the ’File’ menu, by right clicking or dragging the mouse
or, in some cases, by pressing buttons on the toolbar.
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Editing is always performed in the right hand panels.
When in edit mode (data grid) it is necessary to move the
cursor focus away from the current cell (or to press
ENTER) to register the last edit.
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NOTE: When editing data using Microsoft DataGrid, it is
necessary to press the enter key after changing data,
else the data will not be saved after exiting the edit mode.

Mouse – RightClick – Edit
ToolBar – Edit button

Right-clicking on a tree node permits actions on the
displayed list items (right panel).

Cut Item(s):
Menu – Edit – Cut

Right-clicking on the background of the list view panel will
also permit actions on the displayed list items.

ToolBar – Cut button
KeyBoard – Ctrl – X

Right-clicking on a list view item will permit actions (e.g.
deletion) on the selected item only.
List views (right panel) may be sorted by column by
clicking the required column header to select it and
clicking again to sort. Subsequent clicks reverse the sort
order.

Copy Item(s):
Menu – Edit – Copy
ToolBar – Copy button
KeyBoard – Ctrl - C

The following actions are only available when valid items
are selected (or in some cases have the focus):

Paste Item(s):
Menu – Edit – Paste
ToolBar – Paste button
KeyBoard – Ctrl - V

Add New Item:
Menu – File – AddNew
Mouse – RightClick – AddNew

Select All
Menu – Edit – Select All
KeyBoard – Ctrl – A

Delete Item:
Menu – File – Delete
Mouse – RightClick – Delete
ToolBar – Delete button “X”
KeyBoard – Delete Key

Select Multiple
KeyBoard – Ctrl – LeftClick
Invert Selection
Menu – Edit – Invert Selection

Edit Item(s):
Menu – File – Edit

500-61202-002 Rev. E
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3 DOWNLOADING DATA TO
THE METER
NOTE: The L612 hand-meter has an auto shut off
function that will turn meter power off after 60
seconds of inactivity. This may cause a
communications error when interfacing with StatPak. The solution is to turn on the L612 power again,
and retry the communication with Stat-Pak.
The Stat-Pak program has a 4-panel layout as shown in
the figure below. The upper left panel is the Stat-Pak
Database Directory Tree. Double-Clicking on the folders
will reveal the associated Stat-Pak files in the upper left
panel.
The lower left panel is the Moisture Meter Directory Tree.
Clicking on the folders will reveal the associated L612
files in the lower right panel.

Open the ‘Stat-Pak’ computer icon in the top left
window panel (top panel).
Open the ‘Meters’ folder under the ‘Information’
Folder.
Right-click the Meters folder (left hand panel) or rightclick the background of the right hand panel.
NOTE: The cursor must be in the white background area
to select functions that relate to all files within the current
window panel, or have the cursor over the file name to
select functions that relate to the file itself.





Select ‘Add New’.
Right-click again and select ‘Edit’.
Enter the meter number plus any required comments,
then press “Enter”.
Right-click again and de-select ‘Edit’ mode.

Then drag the meter number into the meter by doing the
following:


Data can be moved between the Stat-Pak database to
the L612 by dragging and dropping files between the
upper and lower panels.




DOWNLOAD METER NUMBER TO THE L612



First assign the meter number for the Stat-Pak records.
This number can be arbitrarily assigned by the user to
differentiate data from different meters.
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Open the Moisture Meter icon in the lower left
window panel.
Open the ‘Information’ Folder.
Drag the meter from the Stat-Pak view into the
Moisture Meter view.
If the download is successful the meter number
appears in the Moisture Meter view.

Note: This operation can also be performed by copying
and pasting.
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DOWNLOAD COMPANY NAME TO THE L612
If necessary edit the company name stored in Stat-Pak.










Open the ‘Information’ folder (top panel)
Right-click the Information folder (left hand panel) or
right-click the background of the right hand panel.
Select ‘Edit’.
Edit the company name and press “Enter”, using a
maximum of 30 characters.
Right-click again and de-select ‘Edit’ mode.
Then drag the company name into the meter.
Open the Moisture Meter ‘Information’ Folder (lower
panel)
Drag the company name from the Stat-Pak view into
the Moisture Meter view.
If the download is successful company name appears
in the Moisture Meter view.

Note: This operation can also be performed by copying
and pasting.

Then drag the date and time into the meter.




Open the Moisture Meter ‘Information’ Folder (lower
panel)
Drag the date and time from the Stat-Pak view into
the Moisture Meter view.
If the download is successful the correct date and
time appears in the Moisture Meter view.

Note: This operation can also be performed by copying
and pasting.

DOWNLOAD SPECIES TO THE L612
The meter can store up to 49 species.



Open the Moisture Meter ‘Species’ Folder (lower
panel)
Delete any unwanted species.

Then select the species from the Stat-Pak records.

DOWNLOAD DATE AND TIME TO THE L612
The computer date and time is shown in the Stat-Pak
view. If it is incorrect adjust the time using the Windows
Control Panel.






Open the ‘Species’ folder (top panel).
Open the sub folder containing the required species.
Select the species to be downloaded.

Then drag the species into the meter.

Open the ‘Information’ folder (top panel)

500-61202-002 Rev. E
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Drag the selected species from the Stat-Pak view into
the Moisture Meter view white background area.
If the download is successful the species appear in
the Moisture Meter view.

The Stat-Pak program has a 4-panel layout as shown in
the figure below. The upper left panel is the Stat-Pak
Database Directory Tree. Double-Clicking on the folders
will reveal the associated Stat-Pak files in the upper left
panel.

Note: This operation can also be performed by copying
and pasting.

The lower left panel is the Moisture Meter Directory Tree.
Clicking on the folders will reveal the associated L612
files in the lower right panel.

4 UPLOADING DATA FROM
THE METER

Data can be moved between the Stat-Pak database to
the L612 by dragging and dropping files between the
upper and lower panels.

L612 group data and species settings will be
automatically uploaded to the Stat-Pak program view
(lower panels) upon program launch. If you need to reupload meter data, you can select View-Refresh from the
pull down menu, or use the F5 key.

UPLOAD MEASUREMENT DATA INTO STAT-PAK
Create a new ‘Data Set’ folder to contain the meter data.



NOTE: The L612 hand-meter has an auto shut off
function that will turn meter power off after 60 seconds of
inactivity. This may cause a communications error when
interfacing with Stat-Pak. The solution is to turn on the
L612 power again, and retry the communication with
Stat-Pak.
NOTE: If the program fails to communicate with the
meter and displays an error message “unable to initialize
communications port 1”, there may be an improperly
terminated version of the program running. Perform a
Ctrl-Alt-Delete to bring up the Window Task Manager and
select End Task for the Stat Pak program.
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Open the Stat-Pak ‘Data’ folder (top panel).
Right-click the Data folder (left hand panel) or rightclick the background of the right hand panel.

NOTE: The cursor must be in the white background area
to select functions that relate to all files within the current
window panel, or have the cursor over the file name to
select functions that relate to the file itself.




Select ‘Add New’.
Right-click again and select ‘Edit’.
Enter a description for the data set and press “Enter”.
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Note: The program only supports one level of data set
folders. You can’t create a new folder within the data set.
Choose names for the data set folders that are most
descriptive (i.e. Days-Fir, or Nights-Cedar).






Add the kiln and supplier reference information as
required. These are optional programmable data
entry fields and are not required. The supplier
reference data field allows entry of up to 9
alphanumeric character values, and can be used to
track your lumber supplier shipments if you are using
the meter to measure the moisture content of
incoming lumber.
The meter number is not editable it is the number of
the attached meter.
Right-click again and de-select ‘Edit’ mode.
Open the newly created folder.

Both of these data field entries are optional and not a
required field.
The location data field allows entry up to 5-digit numeric
values. The location field can be used to map your kilns
with a Wagner location coordinate (a ZZ, Y, X, axis 3-D
format) that is currently being used with the Info-Pak Plus
software for inline system report generation as shown in
the following figure. This allows your kiln drying
personnel to know the exact pack location for providing
valuable information necessary to adjust the kilns for
optimum drying performance.

Then drag the group data from the meter into the StatPak folder by doing the following:





Open the Moisture Meter ‘Data’ folder (lower panel)
Select the groups to be uploaded.
Drag the groups from the Moisture Meter view into the
Stat-Pak folder.
If the upload is successful the groups appear in the
folder.

Note: This operation can also be performed by copying
and pasting.
Edit the data by selecting the right mouse key “edit”
function to add location (unit) and reference information.

500-61202-002 Rev. E
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The unit reference data field allows entry of up to 10
alphanumeric character values. This is a customer
programmable data entry field that can be customized to
provide additional information for kiln drying or quality
control personnel.





Then drag the species data from the meter into the StatPak folder by doing the following:


Right-click the open Stat-Pak folder (left hand panel)
or right-click the background of the right hand panel
and select ‘Edit’.
Enter the location information and press “Enter”.
Enter any reference information.
Right-click again and de-select ‘Edit’ mode.






UPLOAD SPECIES DATA INTO STAT-PAK
Create a new ‘Custom’ folder to contain the species data.








Open the Stat-Pak ‘Species’ folder (top panel).
Right-click the Species folder (left hand panel) or
right-click the background of the right hand panel.
Select ‘Add New’.
Right-click again and select ‘Edit’.
Enter a description for the custom species folder and
press “Enter”.
Right-click again and de-select ‘Edit’ mode.
Open the newly created folder.

Or add to an existing ‘Custom’ folder:


Open the Stat-Pak ‘Species’ folder (top panel).
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Open the required custom folder

Open the Moisture Meter ‘Species’ folder (lower
panel)
Select the species to be uploaded. Multiple groups
can be moved simultaneously by depressing the
control key and left mouse clicking on the required
groups.
Drag the species from the Moisture Meter view into
the Stat-Pak folder.
If the upload is successful the species appear in the
folder.

Note: This operation can also be performed by copying
and pasting.

5 WORKING WITH THE DATA
The Stat-Pak program has a 4-panel layout as shown in
the figure below. The upper left panel is the Stat-Pak
Database Directory Tree. Double-Clicking on the folders
will reveal the associated Stat-Pak files in the upper left
panel.
The lower left panel is the Moisture Meter Directory Tree.
Clicking on the folders will reveal the associated L612
files in the lower right panel.
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Data can be moved between the Stat-Pak database to
the L612 by dragging and dropping files between the
upper and lower panels.

CUSTOM SPECIES FOLDERS
New ‘Custom’ folders may be added (and named) as
required.



Select ‘Add New’.




Right-click again and select ‘Edit’.
Enter a description for the custom species folder and
press “Enter”.
Right-click again and de-select ‘Edit’ mode.



The contents of custom folders are editable.
The contents of standard species folders are NOT
editable.
Note: The program only supports one level of data set
folders. You can’t create a new folder within the data set.
Choose names for the data set folders that are most
descriptive (i.e. Days-Fir, or Nights-Cedar).
Species data may be copied (or dragged) between
folders as required.
NOTE: Data dragged into a folder will appear at the end
of the file list until the information is resorted by reopening the window.

EDITING SPECIES DATA
To add a new species data folder



Open the Stat-Pak ‘Species’ folder (top panel).
Right-click the Species folder (left hand panel) or
right-click the background of the right hand panel.
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Open the Stat-Pak ‘Species’ folder (top panel).
Open the required custom folder
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Right-click the folder (left hand panel) or right-click the
background of the right hand panel.

NOTE: The cursor must be in the white background area
to select functions that relate to all files within the current
window panel, or have the cursor over the file name to
select functions that relate to the file itself.


Selecting a ‘Data Set’ folder displays all groups contained
within.
Selecting a group displays the individual group readings.

Select ‘Add New’.

To edit species data:



Open the Stat-Pak ‘Species’ folder (top panel).
Open the required custom folder



Right-click the folder (left hand panel) or right-click the
background of the right hand panel and select ‘Edit’.
Edit the description or specific gravity and press
“Enter”.
Right-click again and de-select ‘Edit’ mode.




Note: The Stat Pak program does not allow you to
delete species data stored in the meter. This operation
must be performed via the L612 hand-meter internal
menu by selecting the “Clear” function as described in
the L612 manual.

Note: Sorting data by kiln, supplier or meter will also
perform a secondary sort by date. Clicking on the
window panel header can perform the sort.

DATA SETS
Creating Data Sets is covered in the section “Upload
Measurement Data into Stat-Pak”
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Note: It is also possible to set a date range to limit the
displayed data –see the System Properties section.
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CREATING SUMMARY REPORTS
Creating a new ‘Summary Report’ folder to contain
custom collections of group data sets.








Open the Stat-Pak ‘Summary Report’ folder (top
panel).
Right-click the Summary Report folder (left hand
panel) or right-click the background of the right hand
panel.
Select ‘Add New’.
Right-click again and select ‘Edit’.
Enter a description for the summary and modify the
date if required, and press “Enter”.
Right-click again and de-select ‘Edit’ mode.
Open the newly created folder.

** This operation can also be performed by dragging
group data from a list view (right panel) and dropping
onto a report summary node (left panel).
Note: It is possible to set a date range to limit the
displayed data -see the System Properties section.
To view or print a Group Summary Report right click the
‘data set’ folder within the summary folder and select
‘View/Print’.

VIEWING REPORTS
To view or print a Group Report right click the group and
select ‘View/Print’.
To view or print a Readings Report right click the group
and select ‘View/Print Readings’.

ADDING GROUPS TO A SUMMARY







Open the Stat-Pak ‘Data’ folder (top panel).
Open the required ‘Data Set’ folder.
Copy the required groups
Return to the Summary Report
Paste the groups into the summary**
If the paste is successful the groups appear in the
folder.

To view or print a Group Summary Report right click the
‘data set’ folder within the summary folder and select
‘View/Print’.

Repeat from other data sets as required.
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PRINTING REPORTS
Printing can be initiated by selecting ‘View/Print’ from the
file menu, clicking the ‘Print’ button, by right-clicking the
mouse and selecting View/Print’ from the pop-up menu or
by pressing the ‘Print’ button on the toolbar.
A print window is always presented first, giving the option
to print if required.
The type of report displayed depends on the node or item
currently selected.
The report may either be printed or exported to an HTML,
or text file.
In addition to printing from the Stat-Pak, Group Reports
and Readings Reports may also be viewed or printed
directly from the meter by right-clicking a group in the
Moisture Meter view (lower panel).
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6 SYSTEM PROPERTIES

To define an end date, check the ‘To’ box and select a
date.
Clicking ‘OK’ will limit displayed information in the upper
right side panel in the Stat-Pak “Data” and “Summary
Reports” folders to the dates set.

There are two properties views dependent upon the
current selection. Clicking the database icon on the tool
bar shown previously or in any blank area inside a left
panel and selecting ‘Properties’ will invoke the ‘File
Information’ properties view. Clicking any other area will
invoke the main system properties view.

DATES TAB
Setting Date Ranges
Allows (optional) selection of start and end dates for
display and printing.
Any dates set up here will be used for all subsequent
date related database queries. The sort is based on the
data folder start date. This field is set by the first data
reading value contained within the folder.

To use these dates as default values in future, simply
check the ‘Set as Default’ box and click ‘OK’
Editing of Data Set 'Start Date' is not possible.
The Data Set creation date is stored internally but is not
used or shown to the user
The Summary Reports include an additional calculated
'Start Date' field determined by the earliest group start
date referenced within it.
Editing of Summary Report 'Start Date' is not allowed.
Summary Reports are now filtered by the calculated start
date.

SETTINGS TAB
Field Widths: If the ‘Use System Defaults’ option is
unchecked then any adjustments made to field widths will
be retained between sessions.

To define a start date, check the ‘From’ box and select a
date.
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The language combo box lists available languages found
in the resource database. If an alternative language is
selected the program must be closed and re-started for
the change to take effect.

Width adjustments can be made by left mouse clicking on
the separator bar between the fields and dragging the bar
in the desired direction. For width adjustments to be
saved, they must be made in non-edit mode. The
change is recorded when the list view is changed or
refreshed.

7 DATABASE FUNCTIONS
OPEN A NEW DATABASE
From the ‘Tools’ menu select ‘Database Utilities’ then
‘Create New Database’

COMMUNICATIONS PORT

Enter the required name and path for the new database
and click ‘Save’.

The combo box lists available ports detected by the
L612Interface DLL. Selecting a number sets the comm.
port to be used.

If the database is to be shared across a network then
place the database file on an appropriate shared drive.

If the COM port number is not listed, as may be the case
if using the USB to serial converter, the port number can
be typed directly into the edit field. Be aware though, that
the COM port may not be listed, because it may be in use
by another program on your computer.

The most recently used database files are listed under
the 'File' menu, this makes it a simple matter to switch
between two or three different databases. For example,
at any time you can select the 'Demo' database to
experiment on or practice with.

LANGUAGE TAB
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COMPACTING THE DATABASE
From the ‘Tools’ menu select ‘Database Utilities’ then
‘Compact Database’
If you delete entries, your database can become
fragmented and use disk space inefficiently. Compacting
the database removes dead space and rearranges how
the database file is stored on disk.

Import Species Information from Stat-Pak Species
File (*.spc)





Select the ‘File – Import - Species’ menu option.
The ‘Open File’ dialog is invoked.
Select a species file (*.spc) and open it.
The species data will be imported to a folder
where the folder name is the filename. If the folder
already exists, it will be overwritten, otherwise it
will be created.



If the filename is the same as one of the default
(non-custom) folders this data will also be
overwritten. This is the only means of modifying
default data.

IMPORT/EXPORT FUNCTIONS
Export Species Information to Stat-Pak Species File
(*.spc)






Right-click the species folder to be exported.
Select the ‘Export – Selected Data to Backup File’
menu option.
The ‘Open File’ dialog is invoked.
The offered filename is the species folder name,
accept or edit it and click OK.
The selected species will be copied to the file.

Note: To import species into a (new or existing) default
folder simply ensure that the filename begins with an
underscore character.

Note: Default folders are saved with a “_” prefix
appended to the filename. If the prefix is removed
the records will be imported as custom data (i.e.
the folder will lose its default status).
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Export Selected Data to Stat-Pak Backup File (*.spb)









Right-click the data set to be exported.
Select the ‘Export – Selected Data Set to Backup
File’ menu option.
The ‘Open File’ dialog is invoked.
The offered filename is the data set description,
accept or edit it and click OK.
The selected data set will be copied to the file.



If the Description, Start Date and Meter Number match
an existing data set the data will be overwritten,
otherwise a new entry will be added.
If data is added but the description matches an existing
entry a sequential number will be appended.

Note: Multiple data set selections are not allowed.
Export Data by Date Range to Stat-Pak Backup File
(*.spb)









Export Selected Report Summary to Stat-Pak Report
Backup File (*.spr)

Set the date range from the ‘Properties’ panel
Right-click the \Data folder.
Select the ‘Export – Selected Data to Backup File’
menu option.
The ‘Open File’ dialog is invoked.
The offered filename is the date range in the
format mmddyy_mmddyy.spb, accept or edit it and
click OK.
The selected data set will be copied to the file.

Import Data from Stat-Pak Backup File (*.spb)
Select the ‘File – Import – Data’ menu option.







Right-click the report summary to be exported.
Select the ‘Export – Selected Data to Backup File’
menu option.
The ‘Open File’ dialog is invoked.
The offered filename is the summary description,
accept or edit it and click OK.
The selected data set will be copied to the file.

Note: Multiple report summary selections are not
allowed.
Export Report Summaries by Date Range to Stat-Pak
Report Backup File (*.spr)
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The ‘Open File’ dialog is invoked.
Select the required data backup file (*.spb) and
open it.
The data set(s) will be imported.
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Set the date range from the ‘Properties’ panel
Right-click the \Summary Reports folder.
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Report backup files include the related data set and
group information these data are imported using the
same criteria as the ‘Import Data’ function.

Select the ‘Export – Selected Data to Backup File’
menu option.
The ‘Open File’ dialog is invoked.
The offered filename is the date range in the
format mmddyy_mmddyy.spr, accept or edit it and
click OK.
The selected data set will be copied to the file.

Export Readings Data in Tab Delimited Text format
(*.txt)



Import Report Summaries from Stat-Pak Report
Backup File (*.spr)










Select the ‘File – Import – Summaries’ menu
option.
The ‘Open File’ dialog is invoked.
Select the required report backup file (*.spr) and
open it.
The data set(s) will be imported.
If the Description, Start Date and Meter Number
matches an existing data set the data will be
overwritten, otherwise a new entry will be added.
If data is added but the description matches an
existing entry a sequential number will be
appended.



Note: Multiple selections are not allowed.
Note: The ‘readings’ suffix is obtained from the resource
file and is therefore translatable.
Export Group Data in Tab Delimited Text format (*.txt)


If the Description, Kiln and Pull Date match an existing
report summary the report will be overwritten, otherwise a
new entry will be added.
If a report is added but the description matches an
existing entry a sequential number will be appended.
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Right-click the data set or report summary to be
exported.
Select the ‘Export – Readings Report (Text
Format)’ menu option.
The ‘Open File’ dialog is invoked.
The offered filename is the report or data set
description followed by “_readings”, accept or edit
it and click OK.
The selected data set will be copied to the file.
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Right-click the data set or report summary to be
exported.
Select the ‘Export – Group Report (Text Format)’
menu option.
The ‘Open File’ dialog is invoked.
The offered filename is the report or data set
description followed by “_group”, accept or edit it
and click OK.

“Stat-Pak” For Windows User’s Guide



generating and editing new language strings in a StatPak resources database.

The selected data set will be copied to the file.

Note: Multiple selections are not allowed.
Note: The ‘group’ suffix is obtained from the resource file
and is therefore translatable.

The Stat-Pak resources database (Resources.wsr) is
loaded as part of the Stat-Pak installation, so this will
need to be present on the computer before the utility can
be used.

Export Charge Data (*.chg)






Right-click the report summary to be exported.
Select the ‘Export – Charge Data’ menu option.
The ‘Open File’ dialog is invoked.
The offered filename is the report or data set
description, accept or edit it and click OK.
The selected data set will be copied to the file.

INSTALLATION REQUIREMENTS
The minimum supported configurations are as follows:
Windows 95 with the Y2K Update (w95y2k.exe) and
Internet Explorer 5.0 or later
Windows 98 with the Y2K Update 2 (y2k.exe +
Y2kw98_2.exe) and Internet Explorer 5.0 or later
Windows 98 Second Edition
Windows Millennium
NT 4 SP5 (or greater) and IE 5.0 or later
Windows 2000
Windows XP

8 LANGUAGE TRANSLATOR
Internationalization of the Stat-Pak program is
accomplished using a language database. The
appropriate text strings are loaded from the database at
run time.

To install Stat-Pak Translator on your hard drive, right
mouse click on the Stat-Pak disk in the CD drive, and
select “open”. Locate the file named T_Setup.exe on the
CD drive and double click on it to initiate the installer
program.

During program development, code added to each form
automatically extracts all text strings and generates an
initial database (in English).
This document relates to the Wagner W32 L612 Stat-Pak
Resource Editor Utility. It describes the process for
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The installer wizard will lead you through the installation
process. Click the Next and Finish buttons to complete
the process.
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By default the application is installed to "C:\Program
Files\StatPak Translator".

By default the source language is English, any available
language may be selected.

Note: If the PC does not have the required version of
Internet Explorer, the installer will exit with an error
message. A compatible version of Internet Explorer has
been provided on the CD for download in the event that
the PC does not have the correct version.

TRANSLATION LANGUAGE
This is the language you wish to translate into.
By default the translation language is English. any
available language may be selected.
To add a new language select ‘Add New Language’ from
the ‘Edit’ Menu, then enter the required language name
and click ‘OK’. The new language will be added to the file
and will appear in the Translation Combo box.

The last page of the installation wizard may report that
your PC will be re-started to complete the installation
process. In this case you will not be able to run the
software until this is done.

Note: The Language name cannot be altered once it has
been created, so it is important to ensure that it is
correctly spelled before continuing.

OPENING A RESOURCE FILE
When the program is run for the first time (and until a file
is opened) no resource file will be loaded. To open a
resource file select ‘Open’ from the ‘File’ menu and locate
the required file (e.g. "C:\Program Files\
StatPak\Resources.wsr").
The selected file will be loaded by default in future
sessions.

SOURCE LANGUAGE

ADDING OR EDITING TEXT
Source text is displayed in a scrollable list on the left side
of the form and translation text (if ‘source’ and
‘translation’ are different) is displayed on the right.
When a row is selected the text is reproduced in the
‘source’ and ‘translation’ text boxes at the top of the form.
These text boxes reflect the font and size used in the
source program. The size of the text box reflects the
space available for the text (when specified).

This is the language you wish to translate.
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Page 30 of 36

“Stat-Pak” For Windows User’s Guide

 Enter the search string in the ‘Find’ text box.
 Press the ‘Find’ Button
The data will be filtered to show only rows containing the
search string.

Text may be entered either in the translation text box or
directly in the translation column.

DESCRIPTION PANEL
Note: The search feature is always active; the menu
option merely makes it visible. To remove the search
filter delete all text from the ‘Find’ text box.

This panel displays descriptions, context information or
other notes associated with the selected text. This is
information that has been added to the source code by
the application programmer.

STATUS BAR INFORMATION

INFORMATION PANEL
This panel displays general information about the object
that uses the text. The information includes the object
type and name, and the form name on which the object is
used.

SEARCH FEATURE
This feature is invoked by selecting ‘Find’ from the ‘Edit’
menu. When selected the Information Panel is replaced
by a ‘Find’ option.
To search for a specific word or phrase do the following:
 Select the ‘Find’ menu option.
 Click on the column to be searched (source or
translation) to select it.
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The status bar at the bottom of the form shows the
following information:
 ‘Form’ – The name of the form on which the text
appears.
 ‘Type’ – The name of the object that uses the text.
 ‘Name’ – The name of the object.
 ‘Index’ – The object index (where applicable). For
some objects, such as Toolbars and Tabstrips the
index denotes the tab or button index.
 ‘Font’ – The font name.
 ‘Size – The font size.
 ‘Records’ – The number of text items. If a search filter
is applied, this number shows the number of text
items containing the search string.
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APPENDIX A
SPECIES LIST
These are the contents of
the factory set species
folders.
Note: SA denotes South Africa

DEFAULT .SPC
Species
Alder,Red
Basswood,Amer
Cedar,EastRed
Cedar,WestRed
Cherry,Black
Douglas Fir
Ebony,E Indn
Elliottii,SA
Euca Grand SA
Fir,Balsam
Fir,Cal Red
Fir,Subalpine
Fir,White
Hemlock,East
Hemlock,West
Hickory,Nutmg
Hickory,Pecan

SG
.41
.37
.47
.32
.50
.50
.70
.49
.70
.35
.38
.32
.39
.40
.45
.60
.66
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Hickory,Mockr
Jelutong
Keruing
Larch,Western
Mahogany,True
Maple,Bigleaf
Maple,Sugar
Oak,Black,Red
Oak,Califrnia
Oak,North Red
Oak,South Red
Oak,Bur,White
Oak,White
Patula, SA
Pine,E White
Pine,Jack
Pine,Loblolly
Pine,Ldgepole
Pine,Longleaf
Pine,Parana
Pine,Pnderosa
Pine,Shrtleaf
Pine,Slash
Pine,Sugar
Poplar,Yellow
Primavere
Redwood, Old
SYP
Taeda,SA
Tamarack
Teak

.72
.46
.64
.52
.59
.48
.63
.61
.51
.63
.59
.64
.66
.50
.35
.43
.51
.41
.59
.54
.40
.51
.59
.36
.42
.45
.40
.51
.58
.53
.59

Walnut,Black
Custm Species

.55
.50

HARDWOOD.SPC
Species
Alder, Red
Apple
Ash, Black
Ash, Blue
Ash, Green
Ash, Oregon
Ash, White
Aspen,Bigtoth
Aspen,Quaking
Basswood,Amer
Beech,Americn
Birch, Paper
Birch, Sweet
Birch, Yellow
Butternut
Cherry, Black
Chestnut,Amer
CottonW,Balsm
CottonW,Black
CottonW,East
Dogwood,Flwr
Elm, American
Elm, Rock
Elm, Slippery
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SG
.41
.61
.49
.58
.56
.55
.60
.39
.38
.37
.64
.55
.65
.62
.38
.50
.43
.34
.35
.40
.64
.50
.63
.53

Hackberry
Hckry,Bittrnt
Hckry,Nutmeg
Hickory,Pecan
Hckry,Water
Hckry,Mockrnt
Hckry,Pignut
Hckry,Shagbrk
Hckry,Shllbrk
Holly,Americn
Hophornbeam,E
Laurel, Cal
Locust,Black
Madrone,Pac
Magnolia,So
Maple,Bigleaf
Maple, Black
Maple, Red
Maple, Silver
Maple, Sugar
Oak, Black
Oak,Cal,black
Oak,Cherrybrk
Oak, Laurel
Oak, No Red
Oak, Pin
Oak, Scarlet
Oak, So Red
Oak, Water
Oak, Willow
Oak, Bur

.53
.66
.60
.66
.62
.72
.75
.72
.69
.50
.63
.51
.69
.58
.50
.48
.57
.54
.47
.63
.61
.51
.68
.63
.63
.63
.67
.59
.63
.69
.64
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Oak, Chestnut
Oak, Overcup
Oak, Post
Oak, Swamp
Oak, White
Persimmon,Com
Poplar,Yellow
Sassafras
Sweetgum
Sycamore,Amer
Tanoak
Tupelo,Black
Tupelo,Water
Walnut,Black
Willow,Black

.66
.63
.67
.72
.66
.64
.42
.46
.52
.49
.58
.50
.50
.55
.39

SOFTWOOD.SPC
Species
Baldcypress
Cedar,Alaska
Cedar,Atlantc
Cedar,Eastern
Cedar,Incense
Cedar,Northrn
Cedar,Port Or
Cedar,Western
Douglas fir
Fir, Balsam
Fir, Cal Red
Fir, Grand
Fir, Noble
Fir,PacSilver

SG
.46
.44
.32
.47
.37
.31
.43
.32
.50
.35
.38
.37
.39
.43
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Fir,Subalpine
Fir, White
Hemlock,East
Hemlock,Mtn
Hemlock,West
Larch,West
Pine,E White
Pine, Jack
Pine,Loblolly
Pine,Lodgeple
Pine,Longleaf
Pine, Pitch
Pine, Pond
Pine,Pnderosa
Pine, Red
Pine, Sand
Pine,Shrtleaf
Pine, Slash
Pine, Spruce
Pine, Sugar
Pine,Virginia
Pine,W.White
Redwood, Old
Redwood,Young
Spruce,Black
Spruce,Englmn
Spruce,Red
Spruce,Sitka
Spruce,White
Tamarack

.32
.39
.40
.45
.45
.52
.35
.43
.51
.41
.59
.52
.56
.40
.46
.48
.51
.59
.44
.36
.48
.38
.40
.35
.42
.35
.40
.40
.36
.53

IMPORT .SPC
Species
Afrormosia
Andiroba
Anegre
Apitong
Avodire
BanakCuangare
CaribbeanPine
Cativo
Cypress
Determa
Ebony,Eindian
Gmelina
Hura
Iroko
Jelutong
Keruing
Koa
Lauan, Red
Lauan, White
Limba
Mahogany,Afr
Mahogany,True
Manni
Mersawa
Mueri Cherry
Obeche
Ocote pine
Okoume
Opepe
Parana pine
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SG
.69
.64
.54
.64
.55
.62
.61
.44
.51
.58
.70
.50
.38
.70
.46
.64
.67
.67
.50
.45
.61
.59
.68
.65
.63
.38
.66
.44
.73
.54

PerobaDeCamps
Peroba rosa
Primavera
Radiata pine
Ramin
RobleQuercus
Santa Maria
Sapele
SpanishCedar
Teak
Yew

.63
.75
.45
.48
.65
.64
.61
.62
.41
.59
.67
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Species – The type of wood, i.e. Douglas Fir.

APPENDIX B

Species Data – Specific Gravity settings that the handmeter uses to compensate for the type of wood.

GLOSSARY

Summary Report – A bar graph report generated from
multiple groups of group data.

Communications Port – Serial computer port 1 or 2
used to interface with the meter.
Data Set – Files that have been uploaded from the handmeter that contain data. Data set files reside in the folder
“Stat-Pak\Data”.

Tool Bar – A bar located at the top of the Stat-Pak
window that allows for user functions.

Export – Saves data from Stat-Pak to a file.
Group Report – A report generated from a set of
readings from the hand-meter shown with a bar graph.
Import – Retrieves data from a file to Stat-Pak.
Language Translator – Allows the user to convert the
program for their language, i.e. English to Spanish.
Measurement Data – Data recorded in the hand-meter.
Meter Number – A number stored in the hand-meter to
identify it from other meters.
Readings Report – A report generated from a set of
readings from the hand-meter shown with individual
readings in numeric form.
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Wagner Meters
326 Pine Grove Road
Rogue River, OR 97537
Phone: (541) 582-0541
Fax: (541) 582-4138
12/12/02

TECHNICAL BULLETIN 17
L612 STAT-PAK FOR WINDOWS SOFTWARE
UPGRADE PROCEDURE
Dear Customer,
In our quest to continually upgrade our products and
services, we have upgraded our Stat-Pak for Windows
software; you will need to perform the following
procedure to upgrade your existing software (if an earlier
version of Stat-Pak for Windows is already installed on
your system):
Note: Uninstalling Stat-Pak removes all database files.
Make sure to backup current information with the
following procedure.
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Backing up your data:
1. To back up current board data, right click on the Data
folder, select Export -> Selected Data to Backup File.
Save the file somewhere easy to find later. Be sure not to
save the file in the folder where the current application is
located, as it may be deleted when uninstalling the old
software version!
2. To backup summary reports, right click on Summary
Reports folder, select Export -> Selected Data to Backup
File. Save the file somewhere easy to find later.
3. To backup your custom species list, open up the
Species folder and right click on the Custom folder, select
Export -> Selected Data to Backup File. Save the file
somewhere easy to find later. Close Wagner Stat-Pak.

Updating Stat-Pak:
1. Go to Start menu -> Settings -> Control Panel ->
Add/Remove Programs. Select Stat-Pak out of the list
and click remove.
2. Now re-install Stat-Pak from your new CD.
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Bringing your data back into Stat-Pak:
1. In Stat-Pak, click on file -> Import -> Data. Find and
open the file you saved earlier.
2. Click on file -> Import -> Summaries. Find and open
the file you saved earlier.
3. Click on file -> Import -> Species. Find and open the
file you saved earlier.

Thank you,
Wagner Meters
Technical Services Dept.
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